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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the e’ studio IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX23T microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX23T Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User's Manual Describes the technical details of the RSK hardware. RSKRX23T User's | R20UT3318EG
Manual
Tutorial Manual Provides a guide to setting up RSK environment, RSKRX23T Tutorial | R20UT3322EG
running sample code and debugging programs. Manual
Quick Start Guide Provides simple instructions to setup the RSK and RSKRX23T Quick | R20UT3323EG
run the first sample. Start Guide
Code Generator Provides a guide to code generation in the e’ studio RSKRX23T Code | R20UT3324EG
Tutorial IDE. Generator  Tutorial
Manual
Schematics Full detail circuit schematics of the RSK. RSKRX23T R20UT3317EG
Schematics
Hardware Manual Provides technical details of the RX23T RX23T Group | RO1UHO0520EJ
microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVvD Digital Versatile Disc

El Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.
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LENESANS

RSKRX23T
RENESAS STARTER KIT

R20UT3324EG0100
Rev. 1.00
Aug 24, 2015

1. Overview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio

IDE code generator plug in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with e’ studio.

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer.

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3324EG0100 Rev. 1.00
Aug 24, 2015 RENESAS
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RSKRX23T 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the e’ studio IDE to create a working project for the RSK platform. The tutorials help explain the

following:
e Project generation using the e’ studio
o Detailed use of the code generator plug in for e studio
e Integration with custom code
e Building the project e’ studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options (level two) and no outputs debugging information
options selected, producing code suitable for release in a product.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-

depth information.

Aug 24, 2015



RSKRX23T 3. Project Creation with e’ studio

3. Project Creation with e studio

3.1 Introduction

In this section the user will be guided through the steps required to create a new C project for the RX23T MCU,
ready to generate peripheral driver code using Code Generator. This project generation step is necessary to
create the MCU-specific source, project and debug files.

3.2 Creating the Project

Start e” studio and select a suitable location for the project workspace

e Start e studio and select a suitable  [[e% Werkspace Launcher =
location for the project workspace. Select a workspace

e studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | [SENYEIEERT - Browse...

[ Use this as the default and do not ask again

0K ] ’ Cancel

e In the Welcome page, click ‘Go to ~ ® ame e
the workbench’. S @

& RENESAS
e2studio
yerview = enesas Tulorials
. Renesas Samples What's New
- Try out the Renesas Samples Find out what is new
’ = i
e Create a new C project by right- [ Project Explorer 53 = <3==5 | :.
clicking in the Project Explorer pave
and selecting ‘New -> C Project’ as
shown. Alternatively, use the menu New » | FY% Project
item ‘File -> New -> C Project’. -
g2y Import & CProject
&y Export £ C++ Project
&1 Refresh F5 | Other. Ctri+M
R20UT3324EG0100 Rev. 1.00 RENESAS Page 9 of 49
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RSKRX23T

3. Project Creation with e’ studio

Enter the project name
‘CG_Tutorial. In  ‘Project type:’
choose ‘Sample  Project'. In

‘Toolchains’ choose ‘Renesas RXC
Toolchain’. Click ‘Next’.

In the ‘Target Specific Settings’
dialog, select the options as shown
in the screenshot opposite.

The R5F523T5AxFM MCU is found
under RX200 -> RX23T -> RX23T -
64 pin.

Click ‘Next'.

Create Directory for Project

Project type:

C Project = @
C Project —
Create C project of selected type [
Project name: | CG_Tutorial|
Use default location
Chworkspace\CG_Tutorial Browse

Toolchains:

4 [= Executable (Renesas)
@ Sample Project

4 [= Static Library (Renesas)
& Sample Project

> = Debug-Only Project

» [ Executable (IAR)

> = Others

> 2= Makefile project

KPIT GMUARM-MNOME-EABI Toolchain
KPIT GMURLTE-ELF Toolchain

KPIT GMURX-ELF Toolchain

KPIT GMUSH-ELF Toolchain

Renesas RXC Toolchain

Renesas SHC Toolchain

@j < Back

Show project types and toolchains only if they are supported on the platform

Net> | [ Finisn ||

Cancel ]

C Project
e2 studio - Project Generation
Select Target Specific Settings

[v203.00

Toolchain Version :

Debug Hardware: [ﬂ (RX)

Data endian :

[ Little-endian data

Select Target:

Select Configurations:

R5F523T5AxFM

[¥] Hardware Debug

[ Debug using Simulator : Debug using simulator

: Debug using hardware

[¥] Release (no debug)

Build configurations will be created in the project only for the selected debug mode
options, however by default the project will be built for the active configuration i.e.,
first configuration selected from group. Based on the device selection you made
(RX200) the debug hardware (E1 (RX)) and debug target (RSF523T5AxFM), debug

configuration will be automatically created for you.

: Project without any debug information

@ <Back || Net> |[ Finsh |[ Cancel
R20UT3324EG0100 Rev. 1.00 RENESAS Page 10 of 49
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RSKRX23T

3. Project Creation with e’ studio

e In the ‘Code Generator Settings
dialog, ensure the ‘Use Peripheral
code Generator’ is checked.

e Click ‘Next'.

e In ‘Select Additional CPU Options’
leave everything at default values.

e Click ‘Next'.

|8 € Project
e2 studio - Project Generation
Code Generator and FIT Settings

V| Use Peripheral code Generator

Use FIT module Download FIT modules

= [E]=]

The &2 studic peripheral code generator automatically generates programs (device drivers) for MCU peripheral functions (clocks,
timers, serial interfaces, A/D converters, DMA controllers, etc.) based on settings entered via a graphical user interface (GUI)
Functions are provided as application programming interfaces (APls) and are not limited to initialization of peripheral functions.
Conventionally, the information "CMCU initial settings", "How to define a target board", "File configuration”, "Names of
functions", "Common interface with user application” etc; has in many cases varied by sample code, so changes needed to be
made to sample code when embedding into a user application. With FIT, there are rules for this information, so each sample code
can be embedded into a user application with ease. Also, the peripheral function drivers and middleware which support FIT have a
common interface with user applications. This makes it easy to port user applications when migrating between RX
microcontrollers.

( User Application ]
Middleware
FIT
cG RTOS
Device Dyjiver Device Driver (BSP)
( MCU |
@ <Back || Met> |[ Fmsh |[ Cancel

C Project

e2 studio - Project Generation

Select Additional CPU Options |

Select Additional CPU Options:

Round: ’Nearest ']
Precision of Double: ’Single precision v]
Sign of Char: ’Unsigned v]
Sign of bit Field: [Unsigned -
Allocate from Lower Bit ’Lower bit v]
Width of Divergence of Function: [24 Bit ']

Specify Global Options:
[] Denormalized number allowed as a result

[] Replace from int with short

[] Enum size is made the smallest

[ Pack structures, unions and classes
[ use try, throw and catch of C++

[T] Use dynamic cast and typeid of C++

[] Saves and restores ACC using the interrupt function

® < Back ” Mext = | [ Finish J ’ Cancel

R20UT3324EG0100 Rev. 1.00
Aug 24, 2015

RENESAS
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RSKRX23T

3. Project Creation with e’ studio

e In the ‘Global Options Settings’ leave
everything at default values.

e Click ‘Next'.

e Inthe ‘Standard Header Files’ dialog,
select C99 for ‘Library
Configuration’.  Untick ‘new(EC++)’
and leave all others at defaults.

e Click ‘Next'.

C Project o o]
e2 studio - Project Generation —(
Global Options Settings |
Patch code generation ’None v]
Fast interrupt vector register: ’None VI
ROM: ’None VI
RAM: ’None VI
Address (H'): 00000000
Address Register: IENone V]
@j < Back ” Mext > ] [ Finish ] [ Cancel ]

C Project

e2 studio - Project Generation
Standard Header Files

E=3 o8 >

Library configuration: | C{C99)

Select Header Files:

runtime : Runtime routines (Checked and disabled by default)
[ ctypeh : Character classification routines
[] math.h : Mathematical/trigonometric operations{double-precision)
[] mathf.h : Mathematical/trigonometric operations(single-precision)
[7] stdarg.h : Variable argument functions
stdio.h : Input/Output
stdlib.h : General purpose library features
string.h : String handling operations
[ ios(EC++) : Input/Cutput Streams
] : Memory allocation and deallocation routines

] complex(EC++)

: Complex number operations

[T] string(EC++) : String manipulation operations
] complex.h(C99) : Performs complex number calculation
[ ferw.h(C99) : Sets floating point environment
[[Jinttypes.h(C99) : Converts integer type format
[T wehar.h(C99) : Performs wide character
&} wetype.h(C939)  : Performs wide character conversion
Select All || Deselect All
@ <Bck || Net> |[ Enish [ Cancel
R20UT3324EG0100 Rev. 1.00 RENESAS Page 12 of 49
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RSKRX23T 3. Project Creation with e’ studio

e In the next dialog, untick all check 7] C Project [o e
boxes except ‘I/O Register Definition
Files' as shown opposite. Click
‘Finish’.

el studio - Project Generation p—

Set various Stack Areas and to add additional Supporting Files |

Stack/Heap Cenfiguration
[ Use User Stack

User's Stack Size: (H") 100

Interrupt Stack Size: (H') 300

[ Use Heap Memory
Heap Size: (H') 400

Generation of Supporting Files

[¥]1/O Register Definition Files

Generate Hardware Setup Function | None -

@j Mext = [ Finish ] ’ Cancel

e A summary dialog will appear, click | summary =]
‘OK’ to complete the project Project Summary:

generaton. PROJECT GENERATOR - R
PROJECT NAME : CG_Tutorial i
PROJECT DIRECTORY : C\workspace\CG_Tutorial
CPU SERIES : RX200

CPUTYPE: RX23T

TOOLCHAIN NAME : Renesas RXC Toolchain
TOOLCHAIN VERSION : v2.03.00

m

GENERATION FILES :

CAworkspace\CG_Tutorial\src\CG_Tutorial.c

Main Program
C\workspace\CG_Tutorial\src\dbsct.c

Setting of B and R sections
C\workspace\CG_Tutorial\src\typedefine.h

Aliases of Integer Type
C\workspace\CG_Tutorial\src\vecttbl.c -

1 b

Click OK to generate the project or Cancel to abort.

oK ] I Cancel

R20UT3324EG0100 Rev. 1.00 RENESAS Page 13 of 49
Aug 24, 2015



RSKRX23T 4. Code Generation Using the e’ studio plug in

4. Code Generation Using the e studio plug in

4.1 Introduction

Code Generator is an e studio plug in GUI tool for generating template ‘C’ source code for the RX23T. When
using Code Generator, the user is able to configure various MCU features and operating parameters using
intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

By following the steps detailed in this Tutorial, the user will generate an e’ studio project called CG_Tutorial.
The fully completed Tutorial project is contained on the RSK Web Installer
(http://www.renesas.com/rskrx23t/install) and may be imported into e studio by following the steps in the
Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for e studio.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK.

Following a tour of the key user interface features of Code Generator in 84.2, the reader is guided through
each of the peripheral function configuration dialogs in 84.3. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

The Code Generator installer is contained on the RSK Web Installer. This installer must be run before
proceeding to the next section.

4.2 Code Generator Tour

In this section a brief tour of Code Generator is presented. For further details of the Code Generator
paradigm and reference, refer to the Application Leading Tool Common Operations manual.

You can download the latest document from: http://www.renesas.com/applilet

Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the
Code Generator.

From the e” studio menus, select ‘Window -> Open Perspective -> Other. In the ‘Open Perspective’ dialog
shown in Figure 4-1, select ‘Code Generator’ and click ‘OK’.

R20UT3324EG0100 Rev. 1.00 RENESANS Page 14 of 49
Aug 24, 2015
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RSKRX23T 4. Code Generation Using the e’ studio plug in

Open Perspective ? @
Bgcr

C++ (default)

[2@ CVS Repository Exploring
ﬁDebug

[k Git

') Planning

™ Resource

B SVN Repository Exploring
£9Team Synchronizing

[ ok [ cance |

Figure 4-1 Open Perspective Dialog

In the Project Explorer pane, expand the ‘Code Generator’ and ‘Peripheral Functions’ node. The Code
Generator initial view is displayed as illustrated in Figure 4-2.

|67 Code Generator - Tutarial/sre/cg _src/r_cg main.c - €2 studio [= & =]
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
B S O S S e Quckrcces [ @ | Brcrce» (A CaamGammmar] 4 bevs
[T Project Explorer 52 =% ¥ = B | Zi "Peripheral Functions 57 | 3 Code Preview [ Properties %] Generate Code (2] ¥ = & e
a (5 CG_Tutorial Clock setting | Block diagram SN=]
’ % Includes Main clock oscillator seting =
e
V| Operation
= CG_Tutorial HardwareDebug.Jaunch P
= 6 Tutorial Release Jaunch Main clock cscillation source Resonator -
custombat Frequency 8 (MHz)
4 ®H| Code Generator .
2 bin View Oscillator wait time 819%2cycles - 2048 )
4 Z Peripheral Functions Oscillation stop detection function Disabled -
& Clock Generator
. W' Voltage Detection Circuit PLL circut setting
W' Clock Frequency Accuracy Measurement C ] Operation
¢ Interrupt Controller Unit Input requency division ratio 1
' Low Power Consumption E
W Buses Frequency multplication factor Wt
W 1O Ports Frequency 2 (MHz)
W' Data Transfer Controller
%' Port Qutput Enable 3 Low speed clock ascillator (LOCO) setting
' Multi-Function Timer Pulse Unit 3 9] Operation
W 8-Bit Timer — 1 T
W' Compare Match Timer
W' Independent Watchdog Timer PR
W Serial Peripheral Interface Clock source Main clock ascillator -
W CRC Calculator
W' Serial Communications Interface System clock (ICLK) x1 ~ 8 (MHz)
W 12-Bit A/D Converter Peripheral module clock (PCLKA) %1 - 8 (MHz)
W' DfA Converter
' Comparator C Peripheral module clock (PCLKE) x1 - 3 (MHz)
@ 1C Bus Interiace Peripheral module clock for ADC (PCLKD) x1 - B (MHz)
W' Data Operation Circuit
» 3 Code Preview Fiash IF clock (FCLK) %1 T (MHz)
[ I + || _IDT-dedicated low-speed clock oscillator (WDTLOCO) setting -
C6_Tutorial/Code ripheral Functions/Clock Generator

Figure 4-2 Initial View

Code Generator provides GUI features for configuration of MCU sub systems. Once the user has configured
all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button, resulting in a
fully configured e” studio project that builds and runs without error.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Code Generator -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Code Generator -> Code Preview on the left.
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RSKRX23T 4. Code Generation Using the e’ studio plug in

4.3 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

4.3.1 Clock Generator

Figure 4-3 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 20 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-3.

28 Peripheral Functions 52 | 5f Code Preview S5l Device Top View 53 Device List View

¢ Clock setting ;| Block diagram |

Main clock oscillator setting

[¥] Operation

Main clock oscillation source Resonator -
Frequency 20 [MHz]
Dscillator wait time 8192 cycles v 2048 [ns)
Ozcillation stop detection function Dizabled -

PLL circuit setting

[¥] Dperation

Input frequency divizion ratio w12 -
Frequency multiplication factor wd -
Frequency 40 [MHz]

Low speed clock oscillator (LOCO] zetting
|| Dperation

Frequency 4 [MHz]

System clock setting

Clock source PLL circuit -

System clock (ICLK) w1 - 40 [MHz]
Peripheral module clock [PCLEA) %1 - 40 [MHz)
Peripheral module clock [FCLKE] w1 v 40 [MHz)
Peripheral module clock for ADC [PCLKD] w1 - 40 [MHz)
Flash IF clock [FCLK) x1/2 - 20 [MHz)

['wDT-dedicated low-speed clock oscillator [MDTLOCO] setting
| Dperation

Frequency 15 [kHz)

Figure 4-3 Clock setting tab

Proceed to the next section on the Interrupt Controller Unit.
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4.3.2 Interrupt Controller Unit

Referring to the RSK schematic, SW1 is connected to IRQ5 (PD6) and SW2 is connected to IRQ2 (P00).
SW3 is connected directly to the ADTRGOn and will be configured later in 84.3.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge
triggered as shown in Figure 4-4 below.

%l Peripheral Functions 52 [f Code Preview [
- Fast interrupt setting

[~] Fast interrupt

Interrupt source

- Software interrupt setting

[ Software interrupt Priprity
NMI setting
[] NMI pin interrupt Valid edge
-|IRQO setting
[ IRQO Pin
Valid edge
-IRQ1 setting -
] 1IRQ1 PFin
Valid edge
IRQ2 setting
[¥] IRQ2 Pin
Valid edge
-IRQ3 setting -
[]IRQ3 Pin
Valid edge
-IRQ4 setting -
] IRQ4 Fin
Valid edge
-IRQ5 setting -
[¥] IRG5 Pin
Valid edge

Properties

BSC (BUSERR vect=16)

Level 15 (highest)

Falling Digital filter
P10 Digital filter
Low level Priority
P11 Digital filter
Low level Pricrity
POO - Digital filter
Falling - Priority
P24 Digital filter
Low level Priority
P23 " Digital filter
Low level Priority
PD& - Digital filter
Falling - Pricrity

No filter

Level 15 (highest)

No filter

Level 15 (highest)

Ne filter

Level 15 (highest)

No filter

—

evel 15 (highest)

No filter

evel 15 (highest)

No filter

Lewvel 15 (highest)

Figure 4-4 Interrupt Functions tab

T

[=]

&

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)
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RSKRX23T 4. Code Generation Using the e’ studio plug in

4.3.3 Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTO’ sub-tab configure CMTO as shown in Figure 4-5. This timer is configured to generate a High
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

f;_dl Peripheral Functians 3 Code Preview 23 Device Tap View 22 Dewice List Wiew
CHMTO | cMT1 | CMT2 | CMT3 |
Compare match timer operation setting

1 Unuzed @ Uszed

Count clock setting
@ PCLE/A 1 PCLEA32 T PCLE A28 T PCLEARTZ

Interval value zetting
Interval value 1 ms w  [Actual value: 1]

Intermupt zetting
Enable compare match interupt [CHI0)

Pricirity Lewel 10 -

Figure 4-5 CMTO tab

Navigate to the ‘CMTL1’ sub-tab and configure CMT1 as shown in Figure 4-6. This timer is configured to
generate a High priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.
E8l Peripheral Functions 32 | 3 Code Preview ZEl Device Top Wiew S8l Dewice List View
| CMTO | CMTT: | cMT2 | ovT3 |
Compare match timer operation getting
O drzed @ Used

Count clock zetting
I PCLE/B @ PLCLE/S32 ) PCLEA 28 ) PCLE/A12

Interval value zetting
Interval value 20 msg w  [fctual value: 20

|mterrupt zetting
Enable compare match interrupt [ChI7]

Fricrity Lewel 10 -

Figure 4-6 CMTL1 tab
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Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-7. This timer is configured to
generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

2l Peripheral Functions 82 | [ Code Preview S5l Device Top View 25l Device List Wiew

| CMTO | £MT1 | CMIZ 1| ouT3 |

Compare match timer operation setting

Unuged @ Usged

Count clack setting
PCLE./8 PCLE./32 PCLEA128 @ PCLE/S12

Interval value zetting
Interval value 200 s *  [Actual walue: 200)

Interrupt setting
| Enable compare match interrupt [CHI12)
Friority Lewvel 10 -

Figure 4-7 CMT2 tab
4.3.4 12-bit A/D Converter

Navigate to the '12-bit A/D Converter’ tab in Code Generator. Refer to the screenshot shown in Figure 4-8,
Figure 4-9 and configure the S12AD as shown. We will be using the S12AD in 12-bit one shot mode on the
ANOOO input, which is connected to the RV1 potentiometer output on the RSK. The conversion start trigger
will be via the pin connected to SW3.

f_JI Peripheral Functions 5% 2 Code Preview ﬁl‘ Device Top View ﬁjl Device List 4iew ] ce
51240 operation setting
Urused @ Used
Operation made setting
@ Single scan mode Group szan mode Continuous scan mode
Double trigger mode zetting
@ Dizable Enable
Self diagnosis setting
Mode Unused -
WVoltage uzed Usze VREFHOO
Disconnection detection assist setting
Charge setting Unused -
Period 2ADCLK
Group scan prionty setting
Group A, priority Group & without priorty
Group B action Mot restarted or continued due to Group & priarity
A/D converted value count setting
@ Addition mode Average mode
High-Potential reference voltage select
@ AVCCO WREFHO
Low-Patential reference voltage select
@ AVSS50 WREFLD
Analog input channel setting
Convert [Group A] Convert [Growp B] Add/dverage AD walue  Dedicated sample and hold
ANOOD Fl
ANOOT
ANOO2
ANOO3
ANOO4
ANOOS
ANOOE
ANOO7
ANOE
ANO?

Internal reference voltage

Figure 4-8 A/D Converter tab-1
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RSKRX23T 4. Code Generation Using the e” studio plug in

— Corweergion start tigger setting
Conversion start trigger [Group A)

AJD corwersion start trigger pin -
Conversion start trigger [Group B]

Compare match with or input capture to WMTU0TGRA

ADTRGOH pin selection Pad -

— Data registers setting

&0 conwerted value addition count 1-time conversion
Data placement Right-alignment -
Automatic clearing Dizable automatic clearing -

- Dedicated sample and hold circuit setting

Input zampling time a [ps]  [Actual value: w)

~ANODO / Self-diagnosis conwersion time setting

Input zampling time 3667 [ns]  [Actual walue: 3.675)

- AM00T conversion time setting

Input sampling time 3.BE7 [ps]  [Actual walue: 3.675]

- AM002 conversion time setting

Input sampling time 3.BE7 [ps]  [Actual walue: 3.675)

- ANDD3 conversion lime setting

Input sampling time J.BE7 [ps]  [Actual walue: 3.675)

—AND04 conversion time setting

Input sampling time 3.EEY [ps]  [Achual value: 3.675)

— ANDDS converzion time zetting

Input zampling time 3.BEF [ps]  [Actual value: 3.675)

— AMODE conversion time setting

Input zampling time 3 BET [ps]  [Actual walue: 3.675)

- AMO07 conversion time setting

Input sampling time 3.BE7 [ps]  [Actual walue: 3.675]

—AM01E - AN 7 conversion tme setting
Input sampling time 3.BE7 [ps]  [Actual walue: 3.675)

—Internal reference volage conversion time setting

Input zampling time 5 [ps]  [Actual value: 5

— Corweergion time zetting

Total conversion time [Group &) 4725 [ps]
Taotal conversion time [Group B) [ps]

[Mote: Continuous sampling iz dizabled)

— Output setting
[ ADSTO pin output enable 1 P02

~ Interrupt setting
Enable AD conversion end interrupt [5124D01)

Priarity Lewel 15 [highest] -
Enable A0 corversion end interupt for group B [GEADI)
Friarity Lewvel 15 [highest]

Figure 4-9 A/D Converter tab-2
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4.3.5 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI5 sub-tab and apply
the settings shown in Figure 4-10. In the RSKRX23T SCI5 is used as an SPI master for the Pmod LCD on the
PMODL1 connector as shown in the schematic.

&4 Peripheral Functions 52 | f Code Preview 25 Device Top View 53 Device List View

[ scn | 505 |

§ General setting ‘ Setting |
Function setting
Unused
) Asynchronous mode Transmizssion/reception
) Asynchronous mode (Multi-processar) Tranzmission
) Clock synchionous mode Transmizsion
) Smart card interface mode Transmission
) Simple IIC bus
@ Simple SPI bus Master transmit only -
Fin setting
RxD5/5MISO5/55CLE PB1
T*D5/5MO515/55DA5 PBS -

Figure 4-10 SCI5 General Setting tab

Select the SCI5 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-11. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to10000000. All other settings remain at
their defaults.

28 Peripheral Functions 52 2 Code Preview 52 Device Top View 28 Device List View

5Ci | SCI8

General setting | Setting |

Transzfer direction zetting

) L5B-first (@) MSB-first
D ata inversion setting

@ Marmal () Inverted
Transfer rate zetting

Tranzfer clock Internal clock. ~ FE7 -

Bit rate 10000000 - [bps]  [Actual walue: 10000000, Erar : 0%]

[] Enable modulation duty correction

SCKS pin function selection Clock output -
Clack setting
Clock delay Clock iz not delayed -

[ Enable clack polarity inversion
D ata handling zetting

Tranzmit data handling [rata handled in interupt service routine -
Interrupt zetting

THI5, TEIS pricrity Level 15 [highest) -

Callback function setting
Tranzmission end

Figure 4-11 SCI5 SPI Master Setting
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Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI1 sub-tab and apply the
settings shown in Figure 4-12. In the RSKRX23T SCI1 is connected via a Renesas RL78/G1C to provide a
USB virtual COM port as shown in the schematic.

ﬁ_xl Petipheral Functions 52 | 3 Code Preview ﬁ_‘J Drewice Top Wiew ﬁ_xl Device List Wiew

General zetting | Setting |
Function setting
1 Unused
@ Asynchronous mode Tranzmizsion/reception -
1 Agynchronous mode [Multi-processor) Transmizzion
~1 Clock gynchronous mode Transmigzion
) Smart card interface mode Tranzmizzion
) Simple IIC bus
) Simple 5Pl bus Slave transmit/receive
Fin zetting
RxD1/SMI501/55CL1 PLS -
TxD1/5M0511 /55041 PD3 -

Figure 4-12 SCI1 General Setting tab

Select the SCI1 ‘Setting’ sub-tab and configure SCI1 as illustrated in Figure 4-13. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings
remain at their defaults.

ﬁjl Peripheral Functions 52 | 2f Code Preview fal Dewvice Top Wiew ﬁjl Dewvice List Wiew ?LI
SC1 | sois

| General setting | Setting |

Start bit edge detection setting

) Low level on B0 pin @ Falling edge on R=D1 pin
Data length setting

) 3bits @ 8 hits ) 7 bits
Parity zetting

@ Maone ~) Even ~ 0dd
Stop bit length setting

@ 1 bit ) 2 bits
Transfer direction setting

@ LSE-first ) MSE-first
Transfer rate setting

Transfer clock Internal clock - FD4

Bit rate 15200 - [bps]  [Actual value: 13230.769, Erar 0.16%)

[ Enable modulation duty corection
SCK1 pin function SCK1 is not used -

Moige filter etting
|| Enable naise fiker

Moise filker clock Clock signal divided by 1 40000000 Hz]
Hardware flow contral setting

@ None I CTS ¢ JRTS 1

CTS1/RTET pin P02

Data handling setting
Transmit data handiing [rata handled in interrupt gervice routine -
Fieceive data handing Data handled in interupt zervice routine -
Intemupt setting
Enable emror interrupt [ERIT]
THI1, Rx1, TEN. ERN priority Lewel 15 [highest] -

Calback function setting
Transmission end Fieception end Reception eror

Figure 4-13 SCI1 Asynchronous Setting
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4.3.6 I/O Ports

Referring to the RSK schematic, LEDO is connected to PA3, LED1 is connected to P71, LED2 is connected to
P72 and LED3 is connected to P73. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four 1/O lines as shown in Figure 4-14 and Figure 4-15 below. Ensure that the ‘Output 1’ tick box is checked.

This ensures that the code is generated to set LEDs initially off.

S5l Peripheral Functions 82 Code Preview 5% Device Top Wiew ©

| Part0 | Part1 | Part2 | Part3 | Portd | Part? | Partd | PDMH PartB | PartD | PartE |

Dewvice List Wiew Fﬂ

Pa2

@ Unused @ In @) Out CHOS output
Pa3

) Unuzed @ In @ Out CMOS output
Pad

@ Unuzed @ In ¥ @ Out (2 CHOS output
Fah

@ Unuzed @ In @ Out CHOS output

- DOutput 1 [ High-drive autput

Figure 4-14 1/O ports — PortA

S8 Peripheral Functions 52 Code Preview =3 Device Top Wiew ©

| Fartd | Part1 | Part2 | Part3 | Fartd | Part? | Part3 | Paorta, | FartB | PartD | FartE |

Dewvice List Wiew i

F70

@ Unused @ In ) Out CHOS output
F71

) Unused @ In @ Out CHOS output
P72

) Unused @ In @ Out CHOS autput
P73

) Unuzed @ In @ Out CMOS output
F74

@ Unuzed @ In @ Out CHOS output
F75

@ Unused @ In ) Out CHOS output
F7E

@ Unused @ In ) Out CHOS output

- Dutput 1
- Dutput 1
- Dutput 1

Figure 4-15 1/O ports — Port7
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P01 is used as one of the LCD control lines, together with P02, P91 and P92. Configure these lines as shown
in Figure 4-16, Figure 4-17.

£l Peripheral Functions 52 [ Code Preview 53 Device Top View  ZE Device List View i
Eﬂ‘ Portl I Fort2 I Port3 I Port4 | Port? | Portd | Portd, | FortB [ PartD | PortE |
-POO
@ Unused Tn @ Out 8 CMOS output
PO
() Unused I @ Out CMOS output - [7] Output 1 || High-drive output
-P02
) Unused @ In @ Out COS output - [¥] Output 1 | High-drive output
Figure 4-16 1/O ports — Port0
28 Peripheral Functions 52 | 5 Code Preview 23 Device Top View 23 Device List View fl
| Fartd | Fart1 | Part2 | Part3 | Fartd | Fart? | M| Farta, | FartB | PartD | FartE |
P31
) Unused T ln @ Out CHOS output - Output 1 [ High-drive output
P32
) Unuzed I n @ Out CMOS output - [] Dutput 1 [ High-drive autput
P33
@ Unuzed In ) Out CHOS output
P34
@ Unuzed In ) Out CHOS output

Figure 4-17 1/O ports — Port9
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RSKRX23T 4. Code Generation Using the e” studio plug in

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘Generate Code’. The Console pane should report ‘The operation of generating file was successful’, as shown

Figure 4-18 below.

QOutput

[X|

M0403002:The generating source folder is: C:\wurkspace\CG_Iutnrial\Q
M0405001:The following files were generated:J
M0409004:cg_srchr_cg main_c was Dverwritten.J
M0409004:cg_srchr_cg dbsct.c was nverwritten‘g
M04039004:cg_srch\r_cg intprg.c was nverwritten_g
M0409004:cg_srch\r_cg resetprg.c was nverwritten.d
M0403004:cg_sre\r_cg_sbrk.c was nveruritten.g
M0409004:cg_srchr_cg vecttbl.c was nverwritten~g
M04039004:cg_src\r_cg_sbrk.h was nverwzitten.ﬁ
M0408004:cg_srchr_cg stacksct.h was nverwritten.g
M0408004:-cg_srchr_cg vect.h was nverwritten.g
M0405004:cg_srchr_cg hardware_ setup.c was nverwritten.#
M0409004:cg_srch\r_cg macrodriver.h was mvexwritten.g
M0403004:cg_src\r_cg_userdefine.h was cverwritten,g
M0403004:cg_src\r_cg_cgc.c was nverwritcen.g
M0409004:cg_sreh\r_cg cgc user.c wWas overwritten.J
M0405004:cg_srchr_cg cgc.h was Dverwzitten.d
M0409004:cg_srch\r_cg icu.c was Dverwritten.ﬁ
M0409004:cg_srch\r_cg icu user.c was nverwritten_g
M0409004:cg_srchr_cg _icu.h was nverwritten_g
M0409000:cg_sreh\r_cg port.c was generated.d
M0403000:cg_sre\r_cg port_user.c was generated-g
M0409000:cg_srch\r_cg port.h was generated_g
M0409004:cg_srchr_cg _cmt._c was nverwritten_g
M0405004:-cg_srchr_cg cmt user.c was nvezwritten.g
M040%004-cg_srehr_cg cmt . h was nverwritten.g
M0409000:cg_srchr_cg sci.c was genE:ated.J
M0403000:cg_srch\r_cg_sci_user.c was generatedAQ
M0409000:cg_src\r_cg_sci.h was generated..|
M040%8004:cg_srchr_cg_sliZad.c was nvezwritten.g
M0409004:cg_sreh\r_cg slZad user.c was ovezwritten.#
M0405004:cg_srchr_cg slZad.h was nverwritten-ﬁ
HM0405003:The operation of generating file was successful.J

[EQOF]

m

All Messages \ *Code Generator ,(: *Rapid Build /

Figure 4-18 Code generator console
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4.4 Building the Project

The project template created by Code Generator can now be built. In the Project Explorer pane expand the
‘src’ folder. The three files created by the New Project Wizard in 83.2 have been excluded from the build
automatically as part of the code generation procedure as shown in Figure 4-19. This is because the main()
function now resides in r_cg_main.c in the cg_src folder and the type definitions and setting of sections has
been handled by the Code Generator.

7 Project Explorer B3 — <,1=’=f> |
4 =% CG_Tutorial [HardwareDebuqg]
» e Includes
4 [ sec
¢ [ Cg_src

> iodefine.h
[# CG_Tutorial.c
[# dhsct.c

] typedefine.h

Figure 4-19 Files excluded from the build by Code Generator

Switch back to the ‘C/C++' perspective using the gy C/C++ button on the top right of the e® studio
workspace. Use ‘Build Project’ from the ‘Project’ menu or the %' button to build the tutorial. The project
will build with no errors.
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5. User Code Integration

In this section the remaining application code is added to the project. Source files found on the RSK Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code
generator files.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

5.1 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Locate the files ascii.h , r_okaya_lcd.h,
ascii.c, and r_okaya_lcd.c on the RSK Web Installer. These files can be found in the Tutorial project for e
studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory. The files will be automatically
added to the project as shown in Figure 5-1.

2 =1
3

[ Project Explarer =

iy

4 5= CG_Tutorial [HardwareDebug]
- 44 Binaries
» pi Includes
4 |58 src
> 4=k £g_src
. [€] ascii.c
. [n] asciih
» [n| indefine.h
» g r_okaya_lcd.c
- [n| r_okaya_lcd.h

[# © Tikarisl -
Figure 5-1 Adding files to the project

In the e’ studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.

/* Start user code for function. Do not edit comment generated here */
#define TRUE (€D

#define FALSE )

/* End user code. Do not edit comment generated here */

In the same folder open the file ‘'r_cg_main.c’ by double-clicking on it. Insert the following code in between the
user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:
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void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSKRX23T ');
R_LCD_Display(1l, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
ks
/* End user code. Do not edit comment generated here */
3

5.1.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in §4.3.5. In
the e’ studio Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the
user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI5_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci5_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI5:

static void r_sci5_callback_transmitend(void)
/* Start user code. Do not edit comment generated here */

sci5_txdone = TRUE;
/* End user code. Do not edit comment generated here */

3
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name: R_SCI5_SPIMasterTransmit

* Description : This function sends SPI5 data to slave device.
* Arguments - tx_buf -

* transfer buffer pointer

* t>©x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI5_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci5_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI5_SPI_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci5_txdone)

/* Wait */
}
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return (status);

N

End of function R_SCI5_SPIMasterTransmit

/
This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.

5.1.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.3.3. Open the file r_cg_cmth
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt() function and insert the following line in the user code area:

static void r_cmt_cmiO_interrupt(void)

/* Start user code. Do not edit comment generated here */
one_ms_delay_complete = TRUE;
/* End user code. Do not edit comment generated here */

¥
Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/

Function Name: R_CMT_MsDelay

Description : Uses CMTO to wait for a specified number of milliseconds
Arguments : uintlé_t millisecs, number of milliseconds to wait
Return Value : None

*oX o+ %

void R_CMT_MsDelay (const uintl6_t millisec)
uintl6é_t ms_count = O;

do
{
R_CMTO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

(o)

R_CMTO_Stop();
one_ms_delay_complete = FALSE;
ms_count++;

} while (ms_count < millisec);

3
/

End of function R_CMT_MsDelay
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5.2 Additional include paths

Before the project can be built the compiler needs some additional include paths added. Select the
CG_Tutorial project in the Project Explorer pane. Use the @ button in the toolbar to open the project settings.

Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the | button as shown in below in

Figure 5-2.

(2 Optimize

- -
Properties for CG_Tutorial = r@
type filter text Settings =1 =

» Resource — - _— e o
Builders a B E:mpHEf Include file directories &l 8 3
4 C/C++ Build 4 Sassrce "$TCINSTALLY/include”
Build Variables e Object
Change Toolchain Vers (22 List

Figure 5-2 Adding additional search paths
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(3 User
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(2 Input
(22 List =
< s Defines 28 8
A Cartinn

In the ‘Add directory path’ dialog, click the ‘Workspace’ button and in the ‘Folder selection’ dialog browse to the
‘CG_Tutorial/src’ folder and click ‘OK’. e studio formats the path as show in Figure 5-3 below.

Directory:

Add directory path

Sfworkspace_loc/${ProjMNamel/src}

=

oK

J|

Cancel

] | Workspace... | [ File system...

-

Figure 5-3 Adding workspace search path

Repeat the above steps to add the ‘src/cg_src’ workspace search path. Select ‘Build Project’ from the ‘Project’

-

menu, or use the

button. e studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSKRX23T

Tutorial Press Any Switch’ on 3 lines in the LCD display.
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5.3 Switch Code Integration

API functions for user switch control are provided with the RSK. Locate the files rskrx23tdef.h, r_rsk_switch.h
and r_rsk_switch.c on the RSK Web Installer. These files can be found in the Tutorial project for e? studio.
Copy these files into the C:\\Workspace\CG_Tutorial\src directory. Import these three files into the project in
the same way as the Icd files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.3.2 and 84.3.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

53.1 Interrupt Code

In the e® studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_icu.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */

Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_ICU_IRQIsFallingEdge
* Description : This function returns 1 if the specified ICU_IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8_t irg_no
* Return Value : 1 if falling edge triggered, O if not
/
uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0x0;
if (ICU.IRQCRLirg_no]-BYTE & _04 ICU_IRQ_EDGE_FALLING)
falling_edge_trig = 1;
¥
return falling_edge_trig;
}
/
* End of function R_ICU_IRQIsFallingEdge
/
/
* Function Name: R_ICU_IRQSetFallingEdge
* Description : This function sets/clears the falling edge trigger for the
* specified ICU_IRQ.
* Arguments : uint8_t irg_no
* uint8_t set_T _edge, 1 if setting falling edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)
iT (1 == set_fT _edge)
ICU.IRQCR[irg_no].BYTE |= _04_ICU_IRQ_EDGE_FALLING;
}
else
ICU. IRQCR[irg_no]-BYTE &= (uint8_t) ~_04_ICU_IRQ_EDGE_FALLING;
}
}
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/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X XN\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irqg_no].BYTE |= _08_ICU_IRQ EDGE RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~ 08_ICU_IRQ_EDGE_RISING;

N

End of function R_ICU_IRQSetRisingEdge

/

/* End user code. Do not edit comment generated here */

Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch._h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irq2_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 2 callback handler */

R_SWITCH_IsrCallback2();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irg5_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 1 callback handler */

R_SWITCH_IsrCallbackl1();

/* End user code. Do not edit comment generated here */

5.3.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch._h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();
/* End user code. Do not edit comment generated here */
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In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMT2_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();
/* End user code. Do not edit comment generated here */

5.3.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 8§4.3.4 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e” studio Project Tree open the file ‘r_cg_userdefine.h’. Insert the following code the user code area,
resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (€D
#define FALSE )

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */

Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX23T ');
R_LCD Display(1, (uint8_t *)'" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
/* End user code. Do not edit comment generated here */
¥

In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch _press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);
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/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */

Next add the highlighted code below in the user code area inside the main() function and the code inside the
while loop, resulting in the code shown below:

void main(void)
{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_Init(Q);

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init ;

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)"™ RSKRX23T ");
R_LCD_Display(1, (uint8_t *)" Tutorial ");

R_LCD _Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD_Start();

while (1U)
{
uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

3

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else iIf (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

}

/* End user code. Do not edit comment generated here */

3
Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code
area for adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name : cb_switch_press

* Description : Switch press callback function. Sets g_adc_trigger flag.

* Argument > hone
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* Return value : none

static void cb_switch_press (void)

{

/* Check if switch 1 or 2 was pressed */
ifT (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2))

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0xO0;

* End of function cb_switch_press

Function Name : get_adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument > none

Return value : uintl6_t adc value

ook X ok N

static uintl6_t get _adc (void)
{

/* A variable to retrieve the adc result */
uintlé_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD_Stop(Q);

/* Start a conversion */
R_S12AD_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)

/* Wait */
}

/* Stop conversion */
R_S12AD_SWTriggerStop();

/* Clear ADC flag */
g_adc_complete = FALSE;

R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */

R_S12AD_Start();

return adc_result;
by
/

* End of function get_adc

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintlé_t adc result

Return value : none

XX % X EN

static void lcd_display_adc (const uintl6_t adc_result)

/* Declare a temporary variable */
uint8_t a;

/* Declare temporary character string */
char lcd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
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Casting to ensure use of correct data type. */
a = (uint8_t)((adc_result & O0xO0F00) >> 8);
Icd_buffer[6] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (uint8_t)((adc_result & 0x00F0) >> 4);
Icd_buffer[7] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));
a = (uint8_t)(adc_result & Ox000F);
Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD_Display(3, (uint8_t *)lcd_buffer);

N

End of function lcd_display_adc

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the user code area for
function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12AD_SWTriggerStart(void);

void R_S12AD_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_S12AD SWTriggerStart

Description : This function starts the AD converter.
Arguments : None

Return Value : None

o X XN

void R_S12AD_SWTriggerStart(void)

IR(S12AD, S12ADI) = 0OU;
IEN(S12AD, S12ADI1) = 1U;

S12AD.ADCSR.BIT.ADST = 1U;
3

/
End of function R_S12AD SWTriggerStart

Function Name: R_S12AD_SWTriggerStop

Description : This function stops the AD converter.
Arguments : None

Return Value : None

O X XN

void R_S12AD_SWTriggerStop(void)
S12AD.ADCSR.BIT.ADST = 0U;

IEN(S12AD, S12ADI) = 0U;
IR(S12AD, S12ADI) = 0U;
3
/
End of function R_S12AD_SWTriggerStop

/* End user code. Do not edit comment generated here */
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Open the file r_cg_sl12ad_user.c and insert the following code in the user code area for global, resulting in the
code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8_t g_adc_complete;
/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_s12ad_interrupt () function, resulting in the code shown
below:

static void r_sl2ad_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

}

Select ‘Build Project’ from the ‘Project’ menu, or use the button. e” studio will build the project with no
errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the Tutorial to add the UART user code.

5.4 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Locate the files
r rsk_debug.h and r_rsk debug.c on the RSK Web Installer. These files can be found in the
RSKRX23T_Tutorial project for e studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory.
Import these two files into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI1_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.5 UART Code Integration

551 SCI Code

In the e studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_sci.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI5_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI1_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;
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/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci5_txdone;
static volatile uint8_t scil_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_scil_callback transmitend()
function:

static void r_scil_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
scil_txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

In the same file, insert the following code in the user code area inside the r_scil_callback_receiveend()
function:

static void r_scil_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */
/* Check the contents of g_rx _char */
iIf (("c® == g_rx_char) || (°C" == g_rx_char))

g_adc_trigger = TRUE;
by

/* Set up SCI1 receive buffer and callback function again */
R_SCI11_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

}

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI1_AsyncTransmit
Description : This function sends SCI1 data and waits for the transmit end flag.
Arguments - tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

ook X X Ok X F XN\

/
MD_STATUS R_SCI1_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
scil_txdone = FALSE;

/* Send the data using the APl1 */
status = R_SCI1_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == scil_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI1_AsyncTransmit

/* End user code. Do not edit comment generated here */
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55.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk debug.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display_adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:
void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ;

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init Q;

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX23T ");

R_LCD Display(1, (uint8_t *)" Tutorial ");

R_LCD Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD_Start();

/* Set up SCI1 receive buffer and callback function */
R_SC11_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* Enable SCI1 operations */
R_SCI1_Start();

while (1U)
uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_trigger = FALSE;

by

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{
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/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_complete = FALSE;
}

else

/* do nothing */
}

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

Function Name : uart_display_adc

/

*

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8_t : adc_count

* uintl6é_t: adc result

* Return value : none

/
static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)
{

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: »xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0OxOF00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0x00F0) >> 4);

uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

* NS

End of function uart_display adc

/
Select ‘Build Project’ from the ‘Build’ menu. e’ studio will build the project with no errors.

The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM &
LPT)' as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI1 (see §4.3.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the SCI1. Return to this point in the Tutorial to add the LED user code.
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5.6 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "rskrx23tdef.h"
/* End user code. Do not edit comment generated here */

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX23T ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD_Start();
/* Set up SCI1 receive buffer and callback function */
R_SCI11_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI1 operations */
R_SC11_Start();
while (1VU)
t
uintl6é_t adc_result;
/* Wait for user requested A/D conversion flag to be set(SW1 or SW2) */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{
adc_count = 0;
led_display_count(adc_count);
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
ks
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g_adc_complete)
{
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/* Get the result of the A/D conversion */

R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */

if (16 == ++adc_count)
{

}

adc_count = 0;

led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
by

else

{
}

/* do nothing */

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/

* Function Name : led_display_count

* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument : uint8_t count

* Return value : none

static void led_display_count (const uint8_t count)

{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t)((count & 0x01) ? LED_ON : LED_OFF);
LED1 = (uint8_t)((count & 0x02) ? LED_ON : LED_OFF);
LED2 = (uint8_t)((count & 0x04) ? LED_ON : LED_OFF);
LED3 = (uint8_t)((count & 0x08) ? LED_ON : LED_OFF);
ks
/
*

End of function led_display count

/* End user code. Do not edit comment

generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. e studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now
the LEDs will display the adc_count in binary form.
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6. Debugging the Project

In the Project Explorer pane, ensure that the ‘CG_Tutorial’ project is selected. To debug the project, click the
5 button. The dialog shown in Figure 6-1 will be displayed.

-

Confirm Perspective Switch @

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It

incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?

[ Remember my decision

| Yes | ’ Mo

Figure 6-1 Perspective Switch Dialog

Click ‘OK’ to confirm that the debug window perspective will be used. The debugger will start up and the code
will stop at the Code Generator function ‘PowerOn_Reset_PC’ as shown in Figure 6-2.
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Debug - CG_Tutorial/src/cg_src/r_cq_resetprg.c - €2 studio
File Edit Source Refactor MNavigate Search Project Run  Window Help

8 i P = - AL S AT SR Lo R B A e BRGR <R > R
%5 Debug &7 % v PSS+ V=08 ®Va

4 CG_Tuterial HardwareDebug [Renesas GDB Hardware Debugging]
4 ;@ CG_Tutorialx [1] Narme
4 7 Thread [1]1 (single core) (Suspended : Signal : SIGINT:Interrupt)
= PowerON_Reset_PC() at r_cg_resetprg.c:66 Oxffc00000
i gdb
g GDB server

[€] r_cg_resetprg.c 52
2 56 ffceeeed - void PowerON_Reset PC(void)

1
- #ifdef _ RXV2
ffceeeve set_extb(__sectop("EXCEPTVECT"));
3 #endif
ffceeel7 set_intb(_ sectop("CIVECT"));
- #ifdef _ ROZ /* Initialize FPSW */
#define _ROUND @x00200001 /* Let FPSW RMbits=81 (round to zero) */
- #else
#define ROUND @8x@e280000 /* Let FPSW RMbits=B@ (round to nearest) */
#endif
- #ifdef _ DOFF
.,‘.‘ e e —— o R - .

UL

El Console 32 = Tasks = Renesas Coverage Memory Usage - - Performance Analysis () Profile ﬁﬁg Real-time Chi

CG_Tutorial HardwareDebug [Renesas GDB Hardware Debugging] gdb

monitor set_io access width,RW,1,clc84-clc86,clc94-clc96,clcad-clcab,clcb2,clcb4,clcb6,deeez,dese
monitor set_io_access_width,RW,1,d8120-d8123,d0128-de12f,7fe010,7fe014,7fe013,7fe090,7felde, 7febd

Figure 6-2 Debugger start up screen

For more information on the e? studio debugger refer to the Tutorial manual. To run the code click the L
button. The debugger will stop again at the beginning of the main() function. Press U again to run the code.
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7. Additional Information

Technical Support

For details on how to use e’ studio, refer to
the help file by opening e® studio, then

selecting Help > Help Contents from the  Window [Help

menu bar. & v @ Welcame

{7) Help Contents
P Search
Dynamic Help

For information about the RX23T group microcontroller refer to the RX23T Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details
Please refer to the contact details listed in section 8 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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